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IMPORTANT SAFETY INFORMATION

RISK OF ELECTRIC SHOCK
DO NOT OPEN

H5 A

ATTENTION: RISQUE DE CHOC ELECTRIQUE - NE PAS OUVRIR

WARNINGE: 10 REDUCE THE RISK OF FIRE OR ELECTRIC
SHOCK DO NOT EXPOSE THIS EQUIPMENT TO RAIN OR MOISTURE

The symbols shown above are internationally accepted symbols
that warn of potential hazards with electrical products. The
lightning flash with arrow point in an equilateral triangle means
that there are dangerous voltages present within the unit. The
exclamation point in an equilateral triangle indicates that it is
necessary for the user to refer to the owner’s manual.

These symbols warn that there are no user serviceable parts
inside the unit. Do not open the unit. Do not attempt to
service the unit yourself. Refer all servicing to qualified
personnel. Opening the chassis for any reason will void the
manufacturer’s warranty. Do not get the unit wet. If liquid is
spilled on the unit, shut it off imnmediately and take it to a dealer
for service. Disconnect the unit during storms to prevent
damage.

SAFETY INSTRUCTIONS

NOTICE FOR CUSTOMERS IF YOUR UNIT IS EQUIPPED WITH A POWER
CORD.

WARNING: THIS APPLIANCE MUST BE EARTHED.
The cores in the mains lead are colored in accordance with the following code:

GREEN and YELLOW - Earth  BLUE - Neutral BROWVWN - Live
As colors of the cores in the mains lead of this appliance may not correspond with
the colored markings identifying the terminals in your plug, proceed as follows:

* The core which is colored green and yellow must be connected to the terminal
in the plug marked with the letter E, or with the earth symbol, or colored green,
or green and yellow.

* The core which is colored blue must be connected to the terminal marked N
or colored black.

* The core which is colored brown must be connected to the terminal marked L
or colored red.

This equipment may require the use of a different line cord, attachment plug, or
both, depending on the available power source at installation. If the attachment
plug needs to be changed, refer servicing to qualified service personnel who
should refer to the table below. The green/yellow wire shall be connected directly
to the units chassis.

WIRE COLOR
CONDUCTOR
Normal Alt
L LIVE BROWN BLACK
N | NEUTRAL BLUE WHITE
E |EARTH GND | GREEN/YEL GREEN

WARNING: If the ground is defeated, certain fault conditions in the unit or in the
system to which it is connected can result in full line voltage between chassis and
earth ground. Severe injury or death can then result if the chassis and earth
ground are touched simultaneously.

LITHIUM BATTERY WARNING

CAUTION!

This product may contain a lithium battery. There is
danger of explosion if the battery is incorrectly replaced.
Replace only with an Eveready CR 2032 or equivalent.
Make sure the battery is installed with the correct
polarity. Discard used batteries according to
manufacturer’s instructions.

ADVARSEL!

Lithiumbatteri - Eksplosjonsfare.Ved utskifting benyttes
kun batteri som anbefalt av apparatfabrikanten. Brukt
batteri returneres apparatleverandgren.

ADVARSEL!

Lithiumbatteri - Eksplosionsfare ved fejlagtig hdndtering.
Udskiftning ma kun ske med batteri av samme fabrikat og
type. Levér det brugte batteri tilbage til leverandgren.

VAROITUS!

Vaihda paristo ainoastaan laitevalmistajan suosittelemaan
tyyppin. Havitd kaytetty paristo valmistajan ohjeiden
mukaisesti.

VARNING!

Explosionsfara vid felaktigt batteribyte. Anvand samma
batterityp eller en ekvivalent typ som rekommenderas av
apparattillverkaren. Kassera anvant batteri enligt
fabrikantens instruktion.

ELECTROMAGNETIC
COMPATIBILITY

This unit conforms to the Product Specifications noted
on the Declaration of Conformity. Operation is
subject to the following two conditions:
* this device may not cause harmful interference,
and
* this device must accept any interference received,
including interference that may cause undesirable
operation.

Operation of this unit within significant ectromagnetic
fields should be avoided.
* use only shielded interconnecting cables.




IMPORTANT SAFETY INFORMATION

WARNING FOR YOUR PROTECTION
PLEASE READ THE FOLLOWING:

KEEP THESE INSTRUCTIONS

HEED ALL WARNINGS

FOLLOW ALL INSTRUCTIONS

DO NOT USE THIS APPARATUS NEAR WATER

CLEAN ONLY WITH A DRY CLOTH.

DO _NOT BLOCK ANY OF THE VENTILATION OPENINGS.
NSTALL IN ACCORDANCE WITH THE MANUFACTURER'’S
INSTRUCTIONS.

DO NOT INSTALL NEAR ANY HEAT SOURCES SUCH AS
RADIATORS, HEAT REGISTERS, STOVES, OR OTHER APPARATUS
(INCLUDING AMPLIFIERS) THAT PRODUCE HEAT.

ONLY USE ATTACHMENTS/ACCESSORIES SPECIFIED BY THE
MANUFACTURER.

UNPLUG THIS APPARATUS DURING LIGHTNING STORMS OR
WHEN UNUSED FOR LONG PERIODS OF TIME.

Do not defeat the safety purpose of the polarized or grounding-type
plug. A polarized plug has two blades with one wider than the other.
A grounding type plug has two blades and a third grounding prong.
The wide b aje or third prong are provided for your safety. If the
provided plug does not fit your outlet, consult an electrician for
replacement of the obsolete outlet.

Protect the power cord from being walked on or pinched
particularly at plugs, convenience receptacles, and the point where
they exit from the apparatus.

Use only with the cart stand, tripod bracket, or table specified by the
manufacture, or sold with the apparatus. When a cart is used, use
caution when moving the cart/apparatus combination to avoid injury

from tip-over.

Refer all servicing to qualified service personnel. Servicing is required
when the apparatus has been damaged in any way, such as power-sup-
ply cord or plug is damaged, liquid has been spilled or objects have
fallen into the apparatus, the apparatus has been exposed to rain or
moisture, does not operate normally, or has been dropped.

POWER ON/OFF SWITCH: For products provided with a power
switch, the power switch DOES NOT break the connection from the
mains.

MAINS DISCONNECT: The plug shall remain readily operable. For

rack-mount or installation where plug is not accessible, an all-pole

mains switch with a contact separation of at least 3 mm in each pole

thlltlﬂ‘be incorporated into the electrical installation of the rack or
uilding.

FOR UNITS EQUIPPED WITH EXTERNALLY ACCESSIBLE FUSE
RECEPTACLE: Replace fuse with same type and rating only.

MULTIPLE-INPUT VOLTAGE: This equipment may require the use of
a different line cord, attachment plug, or both, depending on the
available power source at installation. Connect this equipment only to
the power source indicated on the equipment rear panel. To reduce
the risk of fire or electric shock, refer servicing to qualified service
personnel or equivalent.

U.K. MAINS PLUG WARNING

A molded mains plug that has been cut off from
the cord is unsafe. Discard the mains plug at a
suitable disposal facility. NEVER UNDER ANY
CIRCUMSTANCES SHOULD YOU INSERT A
DAMAGED OR CUT MAINS PLUG INTO A 13
AMP POWER SOCKET. Do not use the mains
plug without the fuse cover in place. Replacement
fuse covers can be obtained from your local retail-
er. Replacement fuses are |3 amps and MUST be
ASTA approved to BS1362.

DECLARATION OF CONFORMITY

Manufacturer’s Name: DigiTech
Manufacturer’s Address: 8760 S. Sandy Parkway
Sandy, Utah 84070, USA

Declares that the product:

Product name: Vx400

Product option: all (requires Class Il power adapter that conforms to
the requirements of EN60065, EN60742, or
equivalent.)

Conforms to the following Product Specifications:
Safety: IEC 60065 (1998)

EMC: EN 55013 (1990)
EN 55020 (1991)

Supplementary Information:

The product herewith complies with the requirements of the Low Voltage
Directive 73/23/EEC and the EMC Directive 89/336/EEC as amended by
Directive 93/68/EEC.

Vice-President of Engineering
8760 S. Sandy Parkway
Sandy, Utah 84070, USA
Date: May 23,2003

European Contact:  Your local DigiTech Sales and Service Office or

Harman Music Group
8760 South Sandy Parkway
Sandy, Utah

84070 USA

Ph: (801) 566-8800

Fax: (801) 568-7583




Warranty

We at DigiTech are very proud of our products and back-up each one we sell with the following warranty:

|. The warranty registration card must be mailed within ten days after purchase date to validate this
warranty.

2. DigiTech warrants this product, when used solely within the U.S., to be free from defects in materials and
workmanship under normal use and service.

3. DigiTech liability under this warranty is limited to repairing or replacing defective materials that show
evidence of defect, provided the product is returned to DigiTech WITH RETURN AUTHORIZATION,
where all parts and labor will be covered up to a period of one year.A Return Authorization number may
be obtained from DigiTech by telephone.The company shall not be liable for any consequential damage as
a result of the product's use in any circuit or assembly.

4. Proof-of-purchase is considered to be the burden of the consumer.

5. DigiTech reserves the right to make changes in design, or make additions to, or improvements upon this
product without incurring any obligation to install the same on products previously manufactured.

6.The consumer forfeits the benefits of this warranty if the product's main assembly is opened and
tampered with by anyone other than a certified DigiTech technician or, if the product is used with AC
voltages outside of the range suggested by the manufacturer.

7.The foregoing is in lieu of all other warranties, expressed or implied, and DigiTech neither assumes nor
authorizes any person to assume any obligation or liability in connection with the sale of this product. In
no event shall DigiTech or its dealers be liable for special or consequential damages or from any delay in
the performance of this warranty due to causes beyond their control.

NOTE: The information contained in this manual is subject to change at any time without notification. Some
information contained in this manual may also be inaccurate due to undocumented changes in the product or
operating system since this version of the manual was completed. The information contained in this version of
the owner's manual supersedes all previous versions.
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Introduction

Congratulations on your purchase of the Vx400. The Vx400 is truly a breakthrough in vocal processing
technology, providing the tools you need for live performance and the professional features you need in the
recording studio. We recommend that you take the time to become better acquainted with what the Vx400
has to offer by going through this User’s Guide with your Vx400 in front of you.

Included Items
Before you get started, please make sure that the following items have been included:

*Vx400 Vocal Effects Processor and USB Computer Recording Interface
* X-Edit Software CD

* Pro Tracks™ Recording Software

« USB Cable

* PSO913B Power Supply

* Warranty Card

The utmost care was taken while your Vx400 was being manufactured. Everything should be included and
in perfect working order. If anything is missing, contact the factory at once. Please help us become
acquainted with you and your needs by completing your warranty card. It is your safeguard should a
problem arise with your Vx400.

The Front Panel
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I. Down/Up Footswitches - These two footswitches are used to select presets, or access the Tuner of the
Vx400. The footswitch on the left decreases, and the middle footswitch increases the preset
number. Press and hold both Footswitches to access the Tuner.

2. Bypass Footswitch - This footswitch bypasses the selected preset. It is also used in conjunction with the

Up Footswitch to access the recorder functions when the Vx400 is connected to your computer
via USB.
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3. Knobs - These knobs perform various functions depending on which mode is selected or whether the
Vx400 is connected to your computer via USB. During performance, the knobs control the Bass
EQ, Mid EQ, Mid Frequency, Treble EQ, and Master Level. If the Vx400 is connected to the
computer via USB, the performance functions of knobs 2, 3, and 4 are Playback Mix, USB |-2 Send
Level, and USB 3-4 Send Level. When editing or accessing the Setup functions, the knobs adjust
the parameter values listed directly above each knob for the selected effect. When the Drum

Machine is on, the knobs control the Pattern, Tempo, and Level. In Tuner mode, the knobs are
used to select the tuning reference.

4. Select Button - This button enters the Edit mode and selects individual effects to be edited. Successive
presses of this button advances through all available effects. You can also use the select
button to perform two shortcuts. First, you can exit from anywhere within Edit mode by
pressing and holding the Select button. Second, you can move directly to the setup row of
the Matrix while in Performance mode by pressing and holding the Select button.

5. Drums - The Drums button turns the built-in drum machine on and off. When the drum machine is
active, the Drums LED lights and the selected drum pattern plays continuously.

6. Matrix - The matrix provides information regarding the current preset, and parameter edit functions. In
performance mode, the LED’s running down the left side of the Matrix identify which effects are
in use for the selected preset. In Edit mode, the LED's indicate the effect selected for editing.

7. Display - The display provides information for different functions depending on the mode that is active. In
Performance mode, the display shows the selected preset name and numeric location. In Edit
mode, the display shows the name and value of the selected parameter. In Tuner mode, the
display shows the note being played and whether the note is sharp, flat, or in tune.

8. Store - The Store button saves your changes to a User Preset.

9. Expression Pedal - The Expression Pedal controls up to three of the Vx400’s simultaneously assigned Effect

Parameters in real time. Almost every Parameter is available for Expression Pedal
control.

Rear Panel
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I. Instrument In - Connect your instrument to this jack.

2. Mic Level - Controls the gain of the Mic Input.
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3. Mic Input - Connect a mic here for recording or live performance mixing of acoustic sources into the
Vx400. Mic signals can remain dry or be processed through the Vx400 effects for both live
and recording applications. The Mic Input accepts either dynamic or phantom powered
condenser microphones.

4. Left/Right Line Inputs - Connect line level sources to these jacks for recording or live performance mixing
into the Vx400. Line signals can remain dry or be processed through the Vx400
effects for live and recording applications.

5. CD/Monitor In - Connect the output of a CD or MP3 player headphone out for listening to music. The
CD/Monitor In can also be used as a monitor input for mixing the output of your
computer’s sound card back into the Vx400 for playback monitoring.

Note: Using the CD/Monitor input for any type of real-time recording monitoring may
result in a time delay depending on your computer’s speed.

6. Headphones - Connect a pair of stereo headphones to this 1/8” jack.

7. 1/4” Line Outputs - Connect these outputs to your amplifier or to a mixing console that accepts 1/4”
unbalanced connections.

8. Balanced Line Outputs- Connect these outputs to your power amplifier/speaker system or to a mixing
console that accepts balanced XLR connections.

9. USB Jack - Connect this jack to your computer’s USB port for recording purposes (see page 25 for more
on using the Vx400’s USB functions).

ATTENTION: The Vx400 can be connected to your computer before installing the USB
drivers if you are using Windows XP™. However, if you are using any software other than
Windows XP, you must install the USB drivers provided on the X-Edit Software CD before
connecting the Vx400 to your computer with the USB cable.

10. Footswitch jack - Connect the RPxFC 3-button footswitch to this jack. The RPxFC provides remote
control of the recording functions of the Vx400 (see page 3| for more on using the

RPxFC functions).

I'l. Power Input - Connect only the DigiTech PS0913B power supply to this jack.
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Making Connections

There are several different connection options available with the Vx400. Before connecting the Vx400, make
sure that the power to your amplifier and the Vx400 is turned off. The Vx400 does not have a power switch.
To turn the Vx400 off, disconnect the included PS0913B power supply from the power jack to an AC outlet.

PA Rig
Connect your microphone to the Input of the Vx400. Connect the balanced XLR Left and Right outputs
to the inputs on your PA mixer and pan each of these channels hard left and hard right. Select FULL as
your Output Mode (see Output Modes on pg 19 on how the XLR and 1/4” outputs can be
implemented for various recording and live applications).

0

Y

Recording Setup

This is the classic recording setup utilizing the Vx400’s mic, instrument and line inputs with a pair of
powered reference monitors connected the Vx400’s XLR outputs. This setup can also be used for live
applications where you would be performing along with playback from the Pro Tracks recording software
running on your computer (see the Output Modes section on page 19 on how the XLR and 1/4”
outputs can be implemented for various recording and live applications).

o
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Applying Power

Before applying power to anything, set your mixer to a flat EQ response (on most mixers, this would be
0). Then do the following:

[. Pull the Mixer’s Master Faders down completely.

2. Connect the plug of the PS0913B power supply to the Power Jack.

3. Connect the other end of the PS0913B power supply to an AC outlet.

4. Turn the Vx400 Master Volume up to 70 (10).

5. Push the Mixer’s Master Faders up to your desired level.

y - A _ - ‘ 1 I %

8 S5 B or- GO0 00
k d o000 0
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’.. ¥ | = [ |e==1.Pull the Master Level Faders

2.Connect the PS0913B to the Power Jack. EEEE S+ down completely.
ssssssss 4= 5 Push the Master Level Faders
—_ up to desired level.

3.Connect the PS0913B to an
AC Outlet.

™~ 4.Turn the Vx400 Master Volume
up to 70.
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The Presets

Presets are named and numbered locations of programmed sounds which reside in the Vx400. Presets are
recalled with the footswitches. The active effects in each preset are indicated by the lighted LED's in the
Effect Matrix. The Vx400 comes with 40 User Presets (Presets 1-40), and 40 DigiTech factory presets (41-
80). The User Presets are locations where you can store your edits. You may not store changes to the
Factory Presets. From the factory, the 40 User Presets are exact duplicates of the 40 Factory Presets.

Performance

When you first apply power to the Vx400, it powers up in Performance mode. Performance mode provides
access to all of the presets within the Vx400 via the Up and Down Footswitches. The Number | Knob (left)
adjusts the Bass, the Number 2 Knob (second from the left) adjusts the amount of Midrange enhancement,
the Number 3 Knob (middle) adjusts the Mid Frequency, the Number 4 Knob (second from the right) adjusts
the amount of Treble (high frequency) enhancement, and the Number 5 Knob (right) adjusts the Master Level
(volume).

Bypass

The Vx400 Presets can be bypassed for clean, unprocessed vocals and instrument signals. To bypass the
Vx400, press the BYPASS Footswitch. The display will read Bypass indicating the preset is bypassed.
Pressing the Up or Down Footswitches advances to the next available preset. Pressing the Bypass
Footswitch again exits you from Bypass and loads that preset.

Tuner

The Tuner lets you quickly tune or check the tuning of any instrument plugged into the Vx400. Enter Tuner
mode by pressing and holding the Up and Down Footswitches simultaneously. The display briefly shows
TUNER indicating that you are in Tuner mode. To begin tuning, play a note on your instrument (a harmonic at
the |2th fret usually works best for guitars). The right 2 characters in the display shows the note being
played. The left characters in the display indicate whether you are sharp or flat. Arrows pointing to the left
(¢ %) indicate the note is sharp and should be tuned down. Arrows pointing to the right (* ’ ’ ) indicate the

note is flat and should be tuned up. When the note is in tune, the display shows ~~’ (-~

Indicates Indicates Display Shows
Note is Flat Note is Sharp Note Played

In Tuner mode, you can change your tuning reference. The default factory setting is A=440 Hz. (displayed as
A=440). Rotate the Number | Knob to select alternate dropped tunings. Alternate tunings are A = Ab A =
G ,and A = Gb. The display window briefly flashes the selected tuning preference.

The output is muted in Tuner mode. The Expression Pedal returns sound to the output allowing signal to be
heard while tuning. Exit tuner mode by pressing any of the 3 Footswitches.
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CD/Monitor In

The CD In feature lets you connect a CD, MP3, or tape player to the Vx400, and play along with your favorite
artists. To use the CD In feature, do the following:
I. Connect the headphone output of your MP3/CD/tape player to the CD/Monitor input using an 1/8”
stereo cable.
2. Press play on your MP3/CD/tape player. The signal from your MP3/CD/tape player is routed to the left,
right, and headphone outputs of the Vx400.

The Monitor In feature can also be used as a monitor input for mixing the output of your computer’s sound
card back into the Vx400 for playback monitoring.

Drum Machine

The Vx400 features a Drum machine that includes several sampled drum patterns which are useful for
developing a good sense of timing. Pressing the Drums button turns on the built-in drum machine (except
when in Store or Bypass mode). When the drum machine is active:

The Number | Knob is used to select the drum Pattern. Choices include:

ROCK 1 HROCKY DANCE! BLUESE URBAN!
ROCK ¢ POP DHNCES uRZZ URBANC
ROCK 3 FPOP IANCES FUNK REGLRE
HROCK ! FPOP3 CNTRY FUNK & CHH
HROCKZ FPOPY CNTRY? SWING! CHA ¢
HROCK S POPS BLUES! SWINGE O55H
MTRNOM

The Number 2 Knob adjusts the drum Tempo and ranges from BPM 40 (40 beats per minute) to BPM240
(240 beats per minute).

The Number 3 Knob adjusts the volume Level of the drum loop and ranges from | to 99.

Press the Drums button again to stop playback of the drum loop.

Mic Input and Level

The Vx400 features a mic input that can be used for mixing or recording vocals and acoustic instruments.
The mic input is equipped with phantom power that can power professional condenser microphones. The
mic preamp is controlled via the Mic Level knob for controlling the gain of the mic signal. To set the mic level
control, follow these steps:

I. Connect a set of headphones to the headphone jack.

2. Sing or play at the loudest volume you will be performing at and adjust the mic Level control until you see
the Clip LED at the top of the Matrix light. Then gradually decrease the control until the light goes out.
This is the optimum setting for the Mic Level.

For application uses of the mic input, see both the Making Connections and Vx400 Setups sections of
this user’s guide.
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Creating Presets
Editing/Creating Presets

Creating your own signature sound with the Vx400 is easy and intuitive. The Vx400 lets you create your own
presets, or fine tune existing presets to suit your needs. When creating or editing a sound, you must start
with one of the User or Factory Presets. It is not possible to start with an empty preset. The preset number
does not need to be the location that you intend to save it to, because you can save it to any User Preset
location during the store process.

To edit or create a Preset:
I. Use the Up or Down Footswitches to select a preset.
2. Once you have found a preset that you want to edit, press the Select button once to enter Edit mode.
3. Use the Select button in conjunction with the Matrix LED's to choose the effect you want to edit.
Successive presses of the Select button advance to the next Effect in the Matrix.
4. Use Knobs [-4 to change parameter values.
5. Store your preset (See this page for more on storing a preset).

Use Select Button
to Select Effect |

Each Knob Adjusts the Parameter
Column Listed Directly Above the Knob

The Matrix

The Matrix identifies the effects and parameters selected for editing. In Edit mode, successive presses of the
Select button advances to the next row of effects. The LED lights indicating which effect group is selected.
Each effect group has up to 4 parameters that can be modified. The knob directly below each column is used
to change the parameter value of the selected effect. As a knob is rotated, the corresponding parameter’s
name and value or status are displayed.

When the stored value of a parameter is changed, the Store LED lights indicating you need to store the
changes. Changing presets, or turning the power off before storing erases all changes made and the Vx400
reverts to the stored values for the preset.

Storing/Copying/Naming a Preset

Once the preset is modified, you may store your settings to any of the 40 User Preset locations (Presets |-
40). The following steps outline the procedure for storing changes to a preset or copying a preset to a
different location:

I. Press the Store button once. The Store button LED blinks and the first character in the display flashes
indicating you can name your new preset.
2. Use Knob | or Up/Down Footswitches to select the alpha-numeric character.
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3. Rotate Knob 2 clockwise to select the next character, and counterclockwise to select the previous

character. Repeat step 2 until the name is complete.

>1. Press Store and
Characters in Display
Flash Individually

0
E
=
0

e
TREBLE
USB 3-8 LEVEL

3. Number 2 Knob
Selects Next or Previous

Characters in Display

I
2.Number 1 Knob
Selects Alpha-Numeric

Characters

4. Once the name is shown in the display, press the Store button. The display will then flash the new name

of the preset.
5. Select the User Preset location of your new preset using Knob 5 or the Up/Down Footswitches. The

display will then flash the new name of the preset.

5
E

4, Press Store Again
Preset Name and Numeric
Location Flash in Display

O
Ol

S
T

<
<

BYPASS

FrrgTach D

5. Select Numeric Destination
with Footswitches or
Number 5 Knob

6. Press the Store button again to save the changes.

Press the Select or Drums buttons at any time to abort storing.

To copy one preset to another preset location is the same as above. Use the footswitches to select the

preset that you want to copy, then follow the steps listed above.
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Vx400’s Effects
About the Effects

The Vx400 can be thought of as having several different microphone and rack effect processors in a single
programmable package. The order in which they are connected can drastically affect the overall sound
quality. The Vx400 has placed the effects in an order for optimum sound quality. The following diagram
shows the order of the effects.

@

Input Level /\9%4/\ $- Mic Model P Compressor »{ Mic Pre / Voice »| Equalizer
A Noise Gate { Volume ! Effects a Delay »| Reverb i Volume |
> —>~ Pedal - Pre — » » — Pedal - Post !

Effect Definitions

Each effect within the Vx400 can be programmed to suit your personal taste and application. Understanding
how these effects alter the sound, and how each parameter alters the effect helps you achieve the sound you
are looking for.The following overview of the Vx400’s effects outlines what each effect and parameter does.

Mic Modeling

Using proprietary algorithms, DigiTech engineering built precise models of a variety of popular
microphones. This technology allows you to make a composite microphone model by removing the
characteristics of a typical dynamic or condenser mic and adding the characteristics of the desired
microphone sound.

Modeling On/Off - The Number | Knob turns the Mic Modeling effect on (Ur) and off (UF).

Source Mic - The Number 2 Knob selects your Source Mic type. There are two types to choose from,

(Dynamic (3YNHMC) or Condenser (CONTEN).

Modeled Mic - The Number 3 Knob selects the Mic Model type. See list below for Mic Model types and
descriptions.

Microphone Model Descriptions/Display Names

Microphone Description Display Name
AKG™ 414 TLII Large Diaphragm Condenser GL DGRL
Neumann™ U87 Al Large Diaphragm Condenser BIG 87
AKG™ C12 Large Diaphragm Tube TUBE

Oktava™ Small Diaphragm Condenser PENCIL
Shure™ SM58 Small Diaphragm Dynamic 58 IvN
Royer™ 121 Ribbon Microphone RIBBON
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Shure™ Green Bullet Large Diaphragm Dynamic - BULLET
Harmonica Mic
Brawner™ VM| Large Diaphragm Condenser BREWNY
Neumann™ M149 Large Diaphragm Condenser NEUTHY
Lawson™ L47MP Large Diaphragm Tube LAWLES
AKG™ 414 ULS Large Diaphragm Condenser SLVGRL
Sennheiser™ 421 MD Large Diaphragm Dynamic SENDYN
Audio Technica™ AT4050 Large Diaphragm Condenser ATCOND
Neumann™ KM184 Large Diaphragm Condenser NEU T BH
Scheops™ MK2I Small Diaphragm Condenser SHERZ
Shure™ KSM32 Large Diaphragm Condenser KISSEM

Shure, AKG, Audio Technica, Neumann, Lawson, Oktava, Royer, Brawner, Sennheiser, and Scheops are Registered trademarks of their respective companies. The aforementioned names and models are
used solely to indicate microphones used for analyzation in the development of this product. It is not implied in any way that there is any association with or endorsement by any of the named
manufacturers.

Compressor/Noise Gate

The Compressor/Noise Gate module is used to control the dynamics of varying signal strengths and
eliminate unwanted noise when a signal isn’t present.

Comp On/Off - The Number | Knob turns the Compressor on (Ur) and off (OF).
Amount - Rotate the Number 2 Knob to adjust the amount of Compression you want applied to the
signal. Ranges from | to 20.
Gain - Rotate the Number 3 Knob to increase the compressor’s output gain. Ranges from 0 to 10dB.
Gate Off/Threshold - Rotate the Number 4 Knob to turn the Noise Gate off (UF) and to adjust the
threshold level. Ranges from | to 99. A higher setting requires a stronger signal to
open the gate.

Mic Pre/Voice

This module selects various Mic Preamp and Voice character types. Tube Pre is a warm professional mic
preamp type for standard vocal usage. Overdrive and Grunge are cutting edge distortion preamp types.
The other nine voice characters produce wild and unnatural vocal sounds.

Voice Type/Off - The Number | Knob selects a vocal type and turn the Mic Pre/Voice types on (Ur) and
off (UF) (see Mic Pre/Voice Type Parameter chart following these for parameter
descriptions).

Parameter | - The Number 2 Knob adjusts the first parameter of the Voice type selected (see Voice

Parameter chart following these instructions).
Parameter 2 - The Number 3 Knob adjusts the second parameter of the Voice type selected (see Voice
Parameter chart following these instructions).
Level - The Number 4 knob controls the preset level for the selected type. Ranges from 0 to 99
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Mic Pre / Voice Parameters

Voice Type Param | Range Param 2 Range
Direct S T T e
Tube Pre GAIN 0-15 It E55 1-50
Overdrive GAIN 0-50 D E55 1-50
Grunge GAIN 0-50 I E55 1-50
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Dark Side BREATH 1-20 i -
Monster 5IZE 1-60 GROWL 1-40
Chipmunk 5IZE 1-30 e -
Lunar RANGE I-10 B S
Lo-Fi IRIVE 0-50 SUBFRE (Sub Freq) 1-18
Robot RANGE 1-50 EIGE 1-50
Wizard RANGE [-50 -

Alien HTE 1-40 INTENS (Intensity) [-50
Telephone SUBFRE (Sub Freq.) 1-35 SIBUNC (Sibilance) [-50

EQ

The EQ module is a 3-band EQ consisting of Bass, Midrange, and Treble. The frequency centers for each
band may vary depending on the selected model.

Bass - The Number | Knob adjusts the low frequency gain. Ranges from -12 to +12dB.

Midrange - The Number 2 Knob adjusts the midrange frequency gain. Ranges from -12 to +12dB.

Mid Frequency - The Number 3 Knob adjusts the midrange frequency. Ranges from 100Hz to 4000Hz.
Treble - The Number 4 Knob adjusts the high frequency gain. Ranges from -12 to +12dB

Mod Effects

The Effects row in the Vx400 is a multi-function module allowing you to select effects such as: Chorus,
Flanger, Phaser, Tremolo,Vibrato, Strobe, Doubler, Envelope, Pixelator, Detune, Pitch, and Whammy ™
effects. When the Effects row is selected, the Number | Knob is used to turn the Effect module on or
off (tFFELT IF), and select the type of Effect to be used. After selecting the type of effect in this
module, the Number 2-4 Knobs can then be used to adjust the individual Parameters associated with the
selected effect. The Number 5 Knob controls the Vx400’s Master Level. The following describes each
Effect and their Parameters in more detail:

Chorus
A Chorus adds a short delay to your signal. The delayed signal is modulated in and out of tune and
then mixed back with the original signal to create a thicker sound.

Parameter | -The Number 2 Knob adjusts the rate (Speed) of the modulation. Ranges from | to 99.

Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulation. Ranges from |
to 99.

FX Level - The Number 4 Knob controls the volume of the Chorus. Ranges from 0 to 99.

Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Flanger

A Flanger uses the same principle as a Chorus but uses a shorter delay time and adds regeneration
(or repeats) to the modulating delay. This results in an exaggerated up and down sweeping motion to
the effect.

Parameter | - The Number 2 Knob adjusts the rate (Speed) of the modulation. Ranges from | to 99.
Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulation. Ranges from |
to 99.
FX Mix - The Number 4 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99
(all wet).
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Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Phaser

A Phaser splits the incoming signal, and then changes the phasing of the signal. This signal is then taken in
and out of phase and mixed back in with the original signal. As the phasing changes, different frequencies
get canceled resulting in a warm sort of twisting sound.

Parameter | - The Number 2 Knob adjusts the rate (Speed) of the modulating phase. Ranges from | to
99.

Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulating phase. Ranges from |
to 99.

FX Level - The Number 4 Knob controls the volume of the Phaser. Ranges from 0 (all dry) to 99.

Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Tremolo
A Tremolo effect modulates the volume of the signal at an even rate.

Parameter | - The Number 2 Knob adjusts the rate (Speed) the volume modulates. Ranges from | to 99.

Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulating volume. Ranges from O (all dry) to
99.

The Number 4 Knob has no function when the Tremolo effect is selected.

Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Vibrato
AVibrato effect modulates the pitch of the incoming signal at an even rate.

Parameter | - The Number 2 Knob adjusts the rate (Speed) at which the pitch modulates. Ranges from |
to 99.

Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulating pitch. Ranges from | to 99.

The Number 4 Knob has no function when the Vibrato effect is selected.

Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Strobe

The Strobe is a tremolo effect that uses a square wave LFO for the modulation of the signal.

Parameter | - The Number 2 Knob to adjust the rate (Speed) at which the LFO modulates. Ranges from
| to 99.

Parameter 2 - The Number 3 Knob controls the intensity (Depth) of the Effect. Ranges from 0 to 99.

The Number 4 Knob has no function when the Strobe effect is selected.

Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Doubler

The Doubler effect adds a slightly delayed signal to the input signal creating a thicker sound as the level is
increased.

FX Level - The Number 4 Knob controls the volume of the doubled signal. Ranges from 0 (all dry) to 99
(all wet).
The Number 2, and 3 Knobs have no function when the Doubler effect is selected.
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Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Envelope
The Envelope is an automatic Wah effect that alters your sound based upon the dynamic attack of the
vocal part being sung or instrument being played.

Parameter | - The Number 2 Knob adjusts the amount of Wah sweep once the Wabh is triggered.
Ranges from | to 99.
Parameter 2 - The Number 3 Knob adjusts the sensitivity or the input signal required to trigger the
Wah effect. Ranges from | to 99.
FX Mix - The Number 4 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99
(all wet).
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Pixelator

The Pixelator effect removes random samples from the input signal which in turn reduces the signal's
quality and creates a granular type effect on the source Higher Amount settings remove more
samples which reduces the signal's intelligibility.

Parameter | - The Number 2 Knob adjusts the amount of random samples being removed from the
source signal. Ranges from | to 50.
Parameter 2 - The Number 3 Knob adjusts the edge of where the sample is being removed. Ranges

from 0 to 99.
FX Mix - The Number 4 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99
(all wet).

Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Detune

A Detuner will make a copy of your incoming signal, take the copied signal slightly out of tune from
the original, and mix the two signals together. The result is a doubling type of effect as if two vocal
parts were being sung together or two instruments were playing the same part together.

Parameter | - The Number 2 Knob adjusts the amount of pitch difference applied to the copied
signal. Ranges from -24 to 24.

FX Level - The Number 4 Knob controls the volume of the detuned note. Ranges from 0 to 99.

Knob’s 3 has no function when the Detune effect is selected.

Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Pitch

A Pitch Shifter copies the incoming signal, then shifts the pitch of the copied note to a different note.
The shifted note is then mixed back with the original signal sounding as if two vocal parts were being
sung in harmony or two instruments were playing in harmony.

Parameter | - The Number 2 Knob adjusts the interval of shifted pitch. Ranges from -24 (semitones
below) to 24 (24 semitones above).

FX Level - The Number 4 Knob controls the volume of the shifted pitch. Ranges from 0 to 99.

The Number 3 Knob has no function when the Pitch Shift effect is selected.

Master Level - The Number 5 Knob controls the Vx400’s Master Level.
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Whammy™

Whammy ™ is an effect that uses the Expression Pedal to bend the pitch of the incoming signal, or add a
bendable harmony with the original signal. As the Pedal is moved, the note will bend either up or down.
The Whammy ™ effect must be linked to the Expression Pedal in order to function. See page 16 for
more information on linking the Expression Pedal.

Parameter | - The Number 2 Knob selects the interval and direction of the pitch bend. Choices are as

follows:

Whammy (no Dry Signal) Harmony Bends (Dry Signal Added)
POCTUF (I octave above) M3) MH3 (a minor third to a Major third)
cOCTUF (2 octaves above) cNIMAI (a second above to a Major third
NI IWN (a second below) above)
REVINT (a second below reversed pedal 3R I4TH (a third above to a fourth above)

action) HTHSTH (a fourth above to a fifth above)
HTHIWN (a fourth below) 5THOCT (a fifth above to an octave above)
'OCTIN (an octave below) HOC TUP (one octave above)
cOC TIN (2 octaves below) HOC T IN (one octave down)
D11V BOM (Dive Bomb) OCTU) I (one octave up to one octave down)

FX Level - The Number 4 Knob adjusts the volume of the Whammy ™. Ranges from 0 to 99.
The Number 3 Knob has no function when the Whammy™ is selected.
Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Note: Only one of the effects in the Effects row can be used at a time.

Delay

Delay is an effect that will record a portion of the incoming signal, and then play it back a short time later.
The recording can repeat just once, several times, or infinitely (which turns off the input to the Delay and
allows you to play over the top of a passage in the Delay loop).

Delay Type/Off - The Number | Knob turns the Delay on (Urn) and off (F) and selects one of the 3
different types of Delay. Values include: JIGTHL (Digital Delay), ANALUG (Analog Delay),
P PONG (Ping Pong Delay).

Delay Time - The Number 2 Knob adjusts the amount of Delay time. Ranges from ¥ M5 through ¢
5EC (10 ms through | sec in 10 ms increments and | sec through 2 sec in 100 ms incre-
ments).

Feedback - The Number 3 Knob adjusts the number of times the delayed signal will repeat. Ranges from

| to 99 and repeat hold (infinite repeat).

Delay Level - The Number 4 Knob adjusts the volume of the delayed signal. Ranges from 0 to 99.

Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Reverb

Reverb can give the listener a sense that the material is being performed in various acoustical
environments. It can provide the tight acoustics of a small room, or the ambience of huge arena.

Reverb Type/Off - The Number | Knob selects the Type of Reverb or acoustic environment and turns the

Reverb off (OF) or on (UN). The Vx400 provides your choice of eight different

environments including:

15



Creating Presets

HALL = Hall GARAGE = Parking Garage
PLATE = Plate CHURCH = Church

J00M =Wood Room ARENA = Arena
CHAMBER = Chamber SPRCE = Space

Decay - The Number 2 Knob adjusts the length of time the Reverb is audible. Ranges from | to 99.

Damping - The Number 3 Knob controls the amount of sound which is absorbed in the simulated
environment. Ranges from 0 to 99.

Reverb Level - The Number 4 Knob adjusts the volume of the Reverb. Ranges from 0 to 99.

Master Level - The Number 5 Knob controls the Vx400’s Master Level.

Expression Pedal

The Expression Pedal on the Vx400 can be assigned to control the Vx400’s Volume, Whammy ™, or just
about any other parameter in real time with your foot. When a parameter has been assigned to the
Expression Pedal, a programmable minimum and maximum value can also be assigned. The procedure for
assigning a parameter to the Expression Pedal is as follows:

I. Select a User or the Factory Preset.

2. Press the SELECT button until the light in the Expression row of the Matrix’s LED begins flashing.

3. Rotate the Number | Knob to select the Expression pedal 1,2, or 3.

Note: You can assign three parameters to the Expression pedal per preset.

4. Rotate the Number 2 Knob to select the parameter the pedal will control.

5. Rotate the Number 3 Knob to adjust the minimum value the pedal (toe up) reaches.

6. Rotate the Number 4 Knob to adjust the maximum value the pedal (toe down) reaches.

7. Press the STORE button to store the changes. See page 8 for more information on storing presets.

The following is a list of the parameters that can be assigned to the Expression pedal:
(Voice and Effect Parameters depend on the type that is currently selected).

Parameter Display Min Value Max Value
Voice Param | Varies Varies Varies
Voice Param 2 Varies Varies Varies
Voice Level yoxLyL I 99

Effect Speed FREAEM Varies Varies
Amount/Depth PARRAM 2 Varies Varies
Effect Level XLEVL 0 99

Effect Mix Fx MIX 0 99
Whammy WHMAMT I 99

Delay Feedback FBACK I 99 R-hold
Delay In Level DLy IN 0 99

Delay Out Level Ly out 0 99
Reverb Decay DECHY I 99
Reverb In Level RyB IN 0 99
Reverb Out Level Ry BOUT 0 99
Volume Pre vOLPRE - s
Volume Post vOLPST e
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V-Switch

The Vx400’s Expression Pedal includes DigiTech’s exclusive V-Switch. The V-Switch allows the Voice Type
to be switched on and off. Applying extra pressure to the toe of the Expression Pedal will engage the V-
Switch and the function of the Expression Pedal will switch between the assigned parameter and Voice off.
The sensitivity or amount of pressure required to engage the V-Switch can be adjusted to suit your
personal taste (or weight of your foot). See page 32 for the V-Switch Sensitivity adjustment procedure.
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Setups Introduction

The Vx400 is equipped with four inputs and four outputs that can be configured several different ways for
both live and recording applications. These configurations are selected in the DRUMS/SETUP row of the
editing matrix using the five editing knobs. Settings include whether the Instrument or Line inputs are routed
through the Vx400’s effects processing and which pair of outputs mic, line, and instrument processing are
routed to. The USB 1-2 Source and USB 3-4 Source knobs are used for configuring how all inputs, mic
processing, and drum machine are routed via USB to the computer for recording applications.

Instrument/Line Setups

The Instrument and Line Setups are configurations for the instrument and line inputs designed primarily
for live performance applications. The Vx400 acts as a mixing device for mic, instrument, and line sources,
and can eliminate the need for a mixer when the Vx400’s outputs are to be plugged directly into a
full-range powered speaker system. When enabled, these inputs can be routed around or through the
Vx400’s effects processing and then mixed directly into the Vx400’s 1/4” and XLR outputs.

Both Instrument and Line inputs have four settings that can be independently selected using the
Instrument and Line knobs in the DRUMS/SETUP row of the effect matrix. The configurations are

as follows:

INSDFF [ LINDFF - Instrument and Line inputs are disabled.

INSIRY [ LINIRY - Inputs routed directly to Vx400’s outputs, bypassing all effects processing.
INSRVB [ LINFY B - Inputs routed through delay and reverb effects of the current preset.
INSFX JLINEFX - Inputs routed through all effects of current preset.

Instrument Routing

Instrument = IN5SF X Instrument = INSRV B Instrument = INSIRY
Instrument Input — l ‘ ‘
Mic - - Noise L] ® XLR Left Output
Model [ Comp [ MicPre(— EQ [ ‘coo° | Effects Delay Reverb ) ) ) .
Voice - +) XLR Right Output

&)
i(%; 1/4" Left Output
1/4" Right Output

Line Input Routing

Line = L INEF X Line=LINRVE Line=LINIRY

Mic | | Mic Pre | | | | Noise | | 1 + XLR Left OUtPUt
(I; Model [ €°™P [ Voice EQ Gate Effects Delay | | Reverb ju% ( ( XLR Right Output
1—%* 1/4" Left Output
+ 1/4" Right Output

Line Left

Line Right
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Output Modes

The Vx400 features both 1/4” and XLR outputs on the rear panel. These jacks let you simultaneously
connect the Vx400 to an amplifier/speaker system on stage via the 1/4” outputs and connect directly to
your PA system via the XLR outputs.

The five output modes for the Vx400 are as follows:

FULL - All input sources are routed out 1/4” and XLR outputs.

Instrument = IN5F X Instrument = IN5RV B Instrument = IN5IRY
Instrument In

Line Left ] [

} ILine=LINEF?< Line = LINR'B Line = LINIRY
Line Right

XLR Left Output
XLR Right Output

1/4" Left Output
1/4" Right Output

DRUMS

i

XLRIRY -The dry Mic signal is routed out the XLR outputs only. All other sources and Mic with all
Effects are routed out the 1/4” outputs.

Instrument = IN5F X Instrument =
Instrument In

NSRYB Instrument = IN5IRY

] .
[

J lLine=LINEF>J Line=LINF\"EI
Line Right ?

O] 1/4" Left Output
0 1/4" Right Output

j jj XLR Left Output

D) XLR Right Output

L=

XLRMOD - The Mic signal with Modulation Effects is routed out the XLR outputs only. All other sources
and Mic with all Effects are routed out the [/4” outputs.

Instrument = IN5F
Instrument In

Instrument = IN3RY B Instrument = INSIRY

Line Left

[ Line = LINEF X

Line Right

1/4" Left Output
1/4" Right Output

XLR Left Output
XLR Right Output

L=
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[
I

HIFY -The dry Mic signal is routed out the 1/4” outputs only. All other sources and Mic with all
Effects are routed out the XLR outputs.

Instrument = IN5F X Instrument = INSRY
Instrument In

Y

Instrument = IN5IRY

Line Left

Line Right

XLR Left Output
XLR Right Output

114" Left Output
1/4" Right Output

/MO

=

- The Mic signal with the Modulation Effects is routed out the 1/4” outputs only. All other
sources and Mic with all Effects are routed out the XLR outputs.

Instrument = IN3F X

Instrument = IN5RV 3 Instrument = INSIRY
Instrument In

Line Left J

J [ Line = LINEF Line = LINRY'B J
Line Right :

XLR Left Output
XLR Right Output

1/4" Left Output

1/4" Right Output
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Recording Introduction

The Vx400’s USB connection provides 4 channels of audio streaming into the computer and 2 channels of
playback from the computer simultaneously. Recording has never been easier thanks to the hands-free
tracking environment that the Vx400 and Pro Tracks™ software provide. The Vx400’s footswitches and Pro
Tracks software work seamlessly together to automatically arm, record, play, and delete tracks totally hands
free. Multiple recording configurations can be selected to best optimize your recording needs. These
configurations are accessed via the Vx400’s effect’s matrix in the DRUMS/SETUP row.

To begin recording you must first install the proper USB drivers and Pro Tracks recording software onto your
Windows® compatible PC. The USB drivers are found on the X-Edit™ Software CD that came packaged
with the Vx400 and the Pro Tracks recording software CD is found in the Pro Tracks box. Please review the
Pro Tracks documentation to ensure your computer system meets the necessary requirements prior to
installation and refer to the DigiTech Software Installation Guide for step by step installation instruc-
tions. Once installed and configured, the Vx400 can then control Pro Tracks and its recording functions.

Connecting the Vx400 to the Computer

The Vx400 comes equipped with a USB cable that is to be connected to your computer whenever you
will be recording or using the X-Edit Editor/Librarian. VWWe recommend that you only use the USB cable
that is shipped with the Vx400 since it has been tested and approved for this specific use. To connect the
Vx400 to the computer, follow these steps:

* Before connecting the Vx400’s USB jack to your computer, consult the DigiTech Software
Installation Guide and follow the instructions for your computers operating system.

|. Begin with the power disconnected from the Vx400.

2. Plug the small end of the USB cable in to the USB jack on the back of the Vx400.

3. Plug the large flat end of the USB cable into an available USB port on your computer.
4. Connect power to the Vx400.

Vx400 Recording Setup

The Vx400 has several different input / output configurations called Setups offering a wide variety of
recording possibilities. These are selected using the USB 1-2 Source and USB 3-4 Source knobs in
the Vx400’s effect matrix. For a given recording session, you may want to record a mic with effects, dry
mic, instrument, line inputs, a combination of these, or even re-mic your dry vocal tracks back through the
Vx400. Up to 4 channels of audio can be sent simultaneously to the computer and the knobs in the
SETUP row select how and which audio signals are routed up the USB connection. Each USB Source
routes a pair of signals to the computer. The following sections outline how these signals are routed:

USB -2 Source
5TERED - All input sources that are routed through the Vx400’s effects are sent up USB | and 2.

MOND - All input sources that are routed through the Vx400’s effects are summed to mono and sent up

USB I. Nothing is sent up USB 2
EFFECT - The Effect signal is sent up USB | and 2. Stereo track gets recorded.
S5UM+ M - All input sources that are routed through the Vx400’s effects are summed to mono and sent up
USB I. Dry mic is sent up USB 2.

SUMINS - All input sources that are routed through the Vx400’s effects are summed to mono and sent up
USB I|. Dry instrument signal is sent up USB 2.
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IMIC+I - Dry Mic signal sent up USB I. Dry Instrument signal sent up USB 2.
IRVYMIC - Dry Mic signal sent up USB |. Nothing is sent up USB 2.
IRYLIN - Dry Line Left signal is sent up USB |. Dry Line Right signal is sent up USB 2. Stereo track gets

recorded.
IN5 - Dry Instrument signal is sent up USB |. Nothing is sent up USB 2.
UM5 -Vx400 drum playback is sent up USB |. Nothing is sent up USB 2.
RE I - Playback from Pro Tracks™ is sent from the computer back through the Vx400’s effects
processing, and then sent back up USB | and 2 to be recorded. See Re-micing a Vocal Track

on page 28 for more information on how to use this setting.

USB 3-4 Source

USBUFF - USB 3 and 4 are disabled.

IMIC+I - Dry Mic signal is sent up USB 3. Dry Instrument signal is sent up USB 4.

IT - Dry Mic signal is sent up USB 3. Nothing is sent up USB 4.

IN - Dry Line Left signal is sent up USB 3. Dry Line Right is sent up USB 4.
5 - Dry Instrument signal is sent up USB 3. Nothing is sent up USB 4.

IRU 5 -Vx400 Drum playback is sent up USB 3. Nothing is sent up USB 4.

The following diagrams show how signals are routed through the Vx400’s effects and out the USB port
for recording purposes:

Mic Signal Routing

The microphone signal is routed from the mic input through the Vx400s effects processing and then to
the pairs of outputs. The signal sent up USB can be tapped off either at the input (USB Send Path A),
or after the different Effects modules (USB Send Paths C or D). Signals recorded from USB Send
Path A can be played back later through the Vx400 for re-micing. See Re-Micing a Vocal Track on page 28
for more information on how this feature works.

UsB Dry [A] A  i[B] USB Re-Mic USB Send[C| A USB Send [D] A [E] USB Playback
Send Path 5 : Return Path Path : Path : : Return Path

H
ELLA
Hi-

: : oo =
) : - _ — i P v XLR Left Output
Microphone Input gi{ M"odel H Comp HM‘;;I::%H EQ H 'ém H Effects ‘:' Delay [:] Reverb‘ : ;; XLR Right Output
IJ 1/4" Left Output
J 1/4" Right Output

Mic USB Source Mapping

The microphone signal has three paths in which it can travel up the USB port to the computer. Path A
taps the mic signal off right at the input and sends unprocessed signal up to the USB port. Path C taps
the mic signal after the Effects modules except the Delay and Reverb. Path D taps the mic signal at the
output of the Vx400 and can include any effects processing that may be used. Below is a matrix to show
where the signal is tapped based on how the Mic, USB 1-2 Source, and USB 3-4 Source settings are
configured.
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Routing of Mic Input to USB

USB 3-4 Source |

USB |-2 Source

Instrument Signal Routing

The instrument signal can be routed in different ways through the Vx400. IN50FF disables the
instrument input from being heard but dry instrument signal can still be recorded. IN3IFY routes the
instrument signal around the Vx400’s effects processing and mixes it in at the outputs. IN5R)' B routes

TN

the instrument signal only through the Vx400 Delay and Reverb modules. IN5F X routes the instrument
signal through all of the Vx400’s effects.

UsB Dry [F] A USB Send[C] A UsB Send[D] A :[E] USB Playback
Send Path : Path : Path HE Return Path
Instrument Input s
l Instrument = INSIRY

® T XLR Lc.eft Output
\b/L XLR Right Output

® 114" Left Output
(H—— 1/4" Right Output

Instrument USB Source Mapping

The instrument signal, as can be seen in the previous Instrument Signal Routing diagram, has two paths in
which it can travel up the USB port to the computer. Path F taps the instrument signal off right at the
instrument input and sends unprocessed signal up to the USB port. Path C taps the instrument signal
after the different Effects modules except the Delay and Reverb. Path D taps the signal at the output of
the Vx400 and can include any effects processing that may be used. Below is a matrix to show where the
signal is tapped based on how the Instrument, USB 1-2 Source, and USB 3-4 Source settings are

configured.

Routing of Instrument Inputs to USB

USB 3-4 Source
~.

USB 1-2 Source

K~ /3N /L o/, ]/ v/ u/ <2
S S S YRR
YAy NNV ISY IS IS INT RN NISTRYRYRYS
ey ) S5/ 55/ SIS 8/ S8/ & st/ 5/5/5/58/8/8
INSCFF|F|F|F|F|F|F|e|e|F|e]|e¢ MICOFF | e [F|e|e|F|e
INSIRY|F |F|F|F|F|F || |F|e|- MICORY| e [F || |F|e
INSRVB|D|D|D|D|[F|F|e|[e|F|e] MICRVE| e |F|e|* | F|e
INSFX |D|D|C|D|F|F|e|e|[F[e] MICFY | e |Fle|s|F|e

23



The Vx400 and Recording

24

Line Signal Routing

The line signals, like the instrument signal, can be routed in different ways through the Vx400. L INDFF
disables the line inputs from being being heard but dry line signal can still be recorded. LINIRY routes
the left and right line signals around the Vx400’s effects processing and mixes them in at the left and right
outputs respectively. LINF)' B routes the line signals only through the Vx400 Delay and Reverb modules.
LINEF X sums the left and right line input signals together and then routes this signal through all of the

Vx400’s effects.

USB Dry [G] A usB send[c] usB Send[D] . [E] USB Playback
Send Path Path - Path il Return Path
Line Left : T

r-
(]
3
2

J Line

Line Right

| XLR Left Output
(C XLR Right Output

1/4" Left Output
(®H—— 1/4" Right Output

Line USB Source Mapping

The line input signals, as can be seen in the previous Line Signal Routing diagram, has two paths in which
they can travel up the USB port to the computer. Path G taps the line input signals off right at the line
input and sends unprocessed signal up to the USB port. Path C taps the line input signals after the
different Effects modules except the Delay and Reverb. Path D taps these signals at the output of the
Vx400 and can include any effects processing that may be used. Below is a matrix to show where the
signal is tapped based on how the Line, USB -2 Source, and USB 3-4 Source settings are configured.

Routing of Line Inputs to USB

USB |-2 Source

USB 3-4 Source
~. L

(%) >

e /G A4

RSN &/ /e /g
Line /“7/</W Line /S&S/5/R5/85/R5/R5
LINOFF|G|G|G LINOFF|o|e| o |G|
LINIRY|G|G|G LINIRV | e | o] e |G| o]
LINRVBD|D|D LINRVB| e | o] o D] o]
LINEFX|D|D|C LINEFX| e[ e e D] o]
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Using Pro Tracks™

When Pro Tracks is first launched after installation, you will have to configure the MIDI device and Audio
settings to recognize the Vx400 as the hardware you want to use. These procedures must be followed to
ensure you will be able to record audio through all of the Vx400’s inputs and to enable the hands-free
recording capabilities the Vx400 offers.

NOTE: Read the Software Installation sheet that came packaged with the Vx400 for instruc-
tions on installing USB drivers before connecting the Vx400 to the USB port on your computer
and using Pro Tracks.

Installing Pro Tracks Software

Pro Tracks™ software must be installed on your computer in order to use the recording capabilities of
the Vx400. To install Pro Tracks, please consult the installation instructions provided with the Pro Tracks
installation CD.

Setting Up the DigiTech USB Control

The Vx400 uses MIDI commands through the USB connection to communicate with Pro Tracks. These
commands are used to determine which USB |-2 Source and USB 3-4 Source settings have been selected
so that Pro Tracks can function properly when using the Vx400’s hands-free recording features. To
configure Pro Tracks’ MIDI settings for use with the Vx400 follow the steps outlined below:

l.
2.
3.

Start Pro Tracks application on your computer.

If the Tip of the Day window appears, click the Close button.

If no previous MIDI outputs have been selected, the No MIDI Outputs Selected window will
appear. Click the Choose MIDI Outputs Now button. The MIDI Devices window will open.
Under both Input and Output Selections, choose DigiTech USB Control. Do not select DigiTech
USB X-Edit™ or any other available selections. Click the Move Selected Devices to Top button.
Click the OK button and the window will close.

If the Quick Start window appears, click the Close button.

Setting up the Vx400 for Hands-Free Recording

2.
3.

4.

5.

From the Pro Tracks menu bar, select Options>Control Surfaces. The Control Surfaces window
will appear.

Click the * button to add a new control surface. The Control Surface Settings window will open.
In the Control Surface pull-down menu, select DigiTech Hands-Free. Verify that the Input and
Output port settings still have DigiTech USB Control selected. If they do not, do this now.

Click the OK button. Hands-Free should now be displayed as the Connected Surface in the
Control Surfaces Window.

Click the Close button.

Pro Tracks can now respond to the Vx400 for automated recording functions.
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Setting up Pro Tracks™ for Vx400 Audio
I. From the Pro Tracks menu bar, select Options>Audio. The Audio Options window will appear.
Click the Drivers tab.
2. Under the Input Drivers settings, select DigiTech USB 1-2 In/Out and DigiTech USB 3-4 In
Only and deselect all other options.
3. Under the Output Drivers settings, select DigiTech USB 1-2 In/Out and deselect all other
options.
4. Click the OK button.
5. Click the OK button when the window stating changes will be saved upon re-start appears.
6. Close the Pro Tracks application. When you are prompted to save changed, click No.
7. Re-start the Pro Tracks application again.
8. Close the Tip of the Day and Quick Start windows if they appear.
9. From the Pro Tracks menu bar, select Options>Audio.
0. Verify that the Playback and Record Timing Master settings have DigiTech USB 1-2 In/Out select-
ed. If not, select these now.
I'1. Click the Wave Profiler button at the bottom.
[2. Click the Yes button to continue performing the tests.
I3. When the profiling operation is successfully completed, click the OK button.
[4. Click the OK button to close the Audio Options window if it is still open.

You are now ready to use the YVx400 with Pro Tracks recording software.

CAUTION: Do not disconnect power or disconnect the USB cable from the Vx400 or the
computer while the Pro Tracks software is running. Doing so can result in unpredictable
behavior from your computer’s operating system.



The Vx400 and Recording
Using the Vx400’s Footswitches for Recording

The Vx400’s footswitches are capable of controlling the Pro Tracks™

recording software, creating a hands-

free recording interface. To do this, the Vx400 must be connected to the computer via the included USB

cable and the Pro Tracks application must be installed and open.
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Recording a Track or Tracks

To begin recording a track using the footswitches, follow these steps:

. Start the Pro Tracks application.

I

2. From the Pro Tracks menu bar, select File>New. The New Project File window will appear.
3. From the New Project File window, select Normal - Hands-Free Session.

4. Put the Vx400 footswitches in Recorder mode by pressing and holding the UP and BYPASS

footswitches simultaneously until the display reads FEC 5.

5. From the preset display, press and hold the SELECT button to enter the SETUP row in the Vx400’s

matrix. Otherwise, press the SELECT button several times until the setup row is selected.
6. Select the sources to record using the USB 1-2 Source knob (additional sources can be selected

using the USB 3-4 Source knob).

7. Press the RECORD footswitch. The Vx400’s display reads RECORI. A track or tracks are

automatically inserted in the current session of the Pro Tracks software and recording on these tracks

begins.

8. To stop recording, press the STOP/UNDO footswitch. The Vx400’s display reads 570F and Pro

Tracks stops recording. The wave data for the track(s) can now be viewed on your computer monitor.

Playing Back a Recorded Track

After a track or tracks have been recorded, playing them back is easy. If you want to start playback at the

beginning of a track or song but are someplace other than the end of the song, follow these steps:

|. Press the STOP/UNDO footswitch once. The Vx400 display will read REWIND

rewind to the beginning of the current song.

Pro Tracks will

2. Press the PLAY footswitch. The recorded track(s) will begin playing back.
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Recording Multiple Tracks

After tracks have been recorded, you may want to record other tracks that play along with them. To
record a new track or tracks with previously recorded tracks, follow these steps:

I. From the preset display, press and hold the SELECT button to enter the SETUP row in the Vx400’s
matrix.

2. Select the sources to record using the USB 1-2 Source knob (additional sources can be selected

using the USB 3-4 Source knob).

. Press the STOP/UNDO footswitch twice. This will rewind to the beginning of the current song.

4. Press the RECORD footswitch. The Vx400’s display reads FECORE. A track or tracks are
automatically inserted in the current session of the Pro Tracks software and recording on these tracks
begins.

5. To stop recording, press the STOP/UNDO footswitch.

w

Using the UNDO Footswitch to Erase a Track

You can undo the last take or previous tracks using the Vx400’s footswitches. To undo tracks, follow
these steps:

|. Press and hold the STOP/UNDO footswitch. The Vx400’s display reads UNIU, indicating the last
recorded track(s) are being deleted.

Re-Micing a Vocal Track

Using one of the Dry Microphone configurations for recording gives you the opportunity of playing that
dry take back into the Vx400 for re-processing. The advantages of having this feature are you can
experiment playing the dry vocal take back through different mic models, voice types, effects, or entirely
new presets once you have your other tracks recorded. This helps when trying to fit a vocal effect into a
mix after the song is assembled rather than recording with effects that can’t be undone.

To re-mic a track back through the Vx400, follow these steps:
I. Put the Vx400 footswitches in Recorder mode by pressing and holding the UP and BYPASS
footswitches until the display reads RELC F 5.

. From the Pro Tracks menu bar, select File>New. The New Project File window will open.

. Select the Normal-Hands-Free Session project template.

. Select the SETUP row in the Vx400’s matrix.

. Use the USB 1-2 Source knob to select IR VMIL and USB3-4 Source to Uf F.

. Press the RECORD footswitch. The Vx400’s display reads RFECORI. A track is automatically inserted
in the current session of the Pro Tracks™ software and recording on this track begins.

7. To stop recording, press the STOP/UNDO footswitch. The Vx400’s display reads 570F and

recording will stop. Press Stop again to rewind to the beginning of the track.

ol hWN
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8. In the Out box of the track you just recorded, select B(Digitech USB 1-2 In/Out).
E'r£_4"q_|:&@' s DR

LSS 1.20n

- B (DiaiTech USE 1.2 ni0utt

9. In the tool bar press the Console View button to see the mixing console.
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10. Pan the B - Mains Output hard left and the A - Mains Output hard right.

I'l. Select the SETUP row again and use the USB 1-2 Source knob to select REMIL. This configures
the recording software to playback audio through the Vx400’s effects processing.

12. Press the PLAY footswitch. Put the footswitches back to Performance mode by pressing and holding
the UP and BYPASS footswitches simultaneously until the display reads UFI0WN. You can now
audition presets until you find one you like . Once you have done so, return to Recorder footswitch
mode.

13. Press the STOP/UNDO footswitch twice to rewind to the beginning of the track.

4. Press the RECORD footswitch and the recorder will now insert and record a stereo track of
processed mic or vocals.

I5. To stop recording, press the STOP/UNDO footswitch.
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Vx400 Drums and MIDI

The Vx400’s Drum machine samples are mapped so that they may be triggered by MIDI notes played from
Pro Tracks™. Each of the drum patterns programmed in the Vx400 has been programmed as a MIDI track in
the Pro Tracks project file library.

Note mapping for each of the Vx400’s drum samples is as follows:

30

MIDI Note Sample

36/C3 ... Kick

38D3 ............. Snare

42/F#3 ...l Closed High Hat
46/Bb3 ............ Open High Hat

Recording the Vx400 Drums

The Vx400’s drum machine can be recorded using Pro Tracks. Each of the Vx400 drum patterns have
been saved as pattern template files which can be selected from the Pro Tracks project file library for
playback control of the Vx400’s drum samples. To record the Vx400 drums using the pattern templates
provided in Pro Tracks, follow these steps:

I. From the Pro Tracks menu bar, select File>New. The New Project File window will appear.

2. Select one of the DigiTech Vx400 drum templates and click the OK button. This will open up a new
recording session.

3. On the Vx400, use the either USB 1-2 Source or USB 3-4 Source knobs to select JRUMS.

4. Press the RECORD footswitch. The Vx400's display reads FECORI. A new track is automatically
inserted in the current session of the Pro Tracks software and recording on these tracks begins.

5. To stop recording, press the STOP/UNDO footswitch.

You can use MIDI drum files for playing the Vx400 drum samples if you like as long as the events are
mapped to the MIDI notes shown above. The drum samples of the Vx400 only respond to MIDI messages
transmitted on MIDI channel 10, which is the default channel for General MIDI drums.

Playback Mix

The PLAYBACK MIX knob is an easy way to balance the Vx400’s processing with playback from the Pro
Tracks software using a single control. This function is only available when the Vx400 is connected to the
computer via USB and Pro Tracks is up and running. To change the Vx400/Playback mix, follow these steps:

I. Start playback of a session from Pro Tracks.
2. Turn the playback mix knob to balance the level of Vx400 vocal processing and playback level. When the

display reads USBMIX [ indicates that only Vx400 signals will be heard. Rotating this knob clockwise, you
will begin to hear the playback level increase. U583 V' X500 indicates the Vx400/computer playback mix is a
50/50 mix of both signals. Continuing to rotate the knob clockwise will decrease Vx400 level. X MIX [
indicates that only playback from the computer will be heard.



Utilities
USB 1-2 Level /USB 3-4 Level

The USB 1-2 LEVEL and USB 3-4 LEVEL knobs are used for boosting or cutting the amount of signal
sent out the USB port to the computer. These controls are to be used if the signal level of the input source
(mic, line, instrument) isn’t optimized into your recording software (consult the Pro Tracks User’s Guide for
information on proper recording levels). If the signal is too hot to Pro Tracks, use these controls to decrease
the level. The USB 1-2 Level and USB 3-4 Level knobs control the level for each USB pair of outputs so for
example, if SUMMIL is the selected USB -2 Source, increasing the level for the mic 6dB going up USB 2 will
also increase the summed signal by 6dB going up USB |. To increase or decrease the level of audio going up
to the computer, follow these steps.

I. Sing/play through the Vx400 and check the level of signal reaching the recording software (consult the Pro
Tracks User’s Guide for information on how to view recording signal levels).

2. Use which ever USB Level knob to boost or cut the signal level going to the recording software. The
boost/cut range are -6db (U53! - -b) to +24dB (U581~ H).

Using the RPxFC for Recorder Functions

!
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The Vx400 is equipped with a footswitch jack that lets you connect an optional RPxFC for controlling the
Vx400’s recorder. This 3-button footswitch features functions for STOP/UNDO, RECORD, and PLAY.
The RPxFC is an ideal companion for recording as it lets you leave your Vx400 footswitches setup for
changing presets while the RPxFC is used specifically for controlling the Pro Tracks recording software. Use
only a TRS stereo |/4” cable when connecting the RPxFC to the Vx400.

The RPxFC functions are exactly the same as the Vx400 footswitches when it is in Recording mode. Refer to
section Using the Vx400’s Footswitches for Recording for operating instructions.
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Utilities
Factory Reset

This function resets the Vx400 to its original factory settings. This procedure erase all custom user presets,
and recalibrate the Expression Pedal.

ATTENTION: Performing this function erases all user-programmed data. Be sure you want to

erase the memory and start fresh before continuing with this procedure.

The procedure for performing a Factory Reset is as follows:

I. Disconnect the power supply from the Vx400.

2. Press and hold the Select button while re-connecting the power to the Vx400.

3. When the display reads RESET 7, release the Select button and press the Store button. The display reads
RESET indicating that the Vx400 has reset the original factory settings. At this point, the Vx400 auto-
matically advances to the Expression Pedal calibration menu. Follow steps 4 through 7 of the Expression
Pedal calibration section.

Expression Pedal Calibration

The Expression Pedal needs to be recalibrated after a factory reset. This function is automatically prompted
after a factory reset. In the event the pedal’s calibration fails, or if the pedal does not function properly, it can

be re-calibrated using the Pedal Calibration function. This does not erase the User Presets. The procedure

for Calibrating the Expression Pedal is as follows:

. Disconnect the PS0913B power supply from the power jack on the Vx400.

. Press and hold the Down Footswitch while re-connecting the power.

. Continue to hold the Down Footswitch until the display briefly reads calib (calibration).

. When the display reads T0E N, rock the Expression Pedal forward to the toe down position.

. Press any footswitch. The display reads TOE UF.

. Rock the Expression Pedal back to the toe up position.

. Press any footswitch. The display reads }" 5iWT{H indicating you have entered the V-Switch Sensitivity menu.

. If you do not want to adjust the V-Switch sensitivity, press any footswitch to return to Performance Mode.

Note: If error displays, an error has occurred and steps 4 through 8 should be repeated.

V-Switch Sensitivity

If you want to adjust the sensitivity setting of the V-Switch, follow steps | through 7 of Calibrating the
Expression Pedal and then follow the steps listed below:
I. When the display reads /' 5\ TLH, rock the Expression Pedal forward (toe down) and apply extra pressure

on the toe of the pedal until the display reads JUNE.

TN

2. When display alternates between IUNE (with the V-Switch sensitivity value in the numeric Display) and

Y SWTCHON (or VSWTCHOS depending on whether the V-Switch is on or off), you can audition the
V-Switch sensitivity by applying pressure to the toe of the Expression Pedal.

3. Rotate the Number 5 Knob to change the value of the V-Switch sensitivity. You can audition the new value
by applying pressure to the toe of the Expression Pedal.

4. Once the sensitivity value is selected, press any footswitch. The Vx400 returns to Performance Mode and

your settings are automatically saved.



Trouble Shooting Guide

Audio playback from Pro Tracks™ has pops and clicks.

* Try the Wave Profiler under Options->Audio. This seems to fix most problems. Otherwise, try using MME
drivers in the Options->Audio->Advanced, Driver Mode selection. These are the safest drivers but also
have the most latency.

* Try increasing the latency slider in the audio settings.

Hands-Free recording on Vx400 doesn’t work or has stopped working.
* If it was working at one point but has stopped working, try exiting Pro Tracks and then restarting it (make sure
to save your project).
* Cycle power to the Vx400 before entering Pro Tracks or X-Edit.
* If it has never worked at all, there is a problem with USB MIDI The most probable causes are using incorrect or
incorrectly installed drivers and/or .dll or a bad USB cable.
* See the section on driver installation.

I can’t hear audio playback from Pro Tracks.
¢ If the ‘Remic’ mode in the Vx400 is active try switching to a different mode like ‘Stereo’.
* Make sure the faders in Pro Tracks are turned up.
* Check that the tracks you want to playback are un-muted.
* Go to Options->Audio->Drivers and under output drivers, select ‘DigiTech USB 1-2 In/Out’ and de-select
everything else.
* See the section on driver installation.

My Vx400 doesn’t record to Pro Tracks.
* Go to Options->Audio->Drivers and under input drivers, select ‘DigiTech USB 1-2 In/Out’ and ‘DigiTech
USB 3-4 In Only’ De-select everything else.
* Make sure the proper drivers are installed.
* See the section on driver installation.

 For an initial track, make sure ‘?EMIL’ mode in the Vx400 is not used.

I can’t get Re-Micing to work.
* See the Re-Micing a Track section of this user’s guide.

Pro Tracks intermittently locks up.
* Close any other open programs besides Pro Tracks. Check "Task Manager" to make sure there are no hidden
programs running.
* Try reducing the number of plug-ins and soft-synths.
* Increase the amount of memory in your system.
* Get a faster hard drive.
* Put your audio data on a different hard drive from your OS and applications.
* Get a faster computer.
* Please refer to the system requirements section.

Where did my wave files go?
* Wave files all get saved to the folder specified in Options->Global, Audio Data.

My waves are low/too high in level.
* The recording signal level can be boosted or reduced using the USBI-2 and USB3-4 level controls.

Pro Tracks playback is louder than my voice.
* You can adjust the mix of playback versus microphone by using the Playback mix knob.
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Trouble Shooting Guide

I get audio dropout while I’'m recording.

* Try increasing the latency slider in the Audio settings.

* Try reducing the number of tracks in your project (mute won't help, you either have to "archive" the tracks, or
delete them)

* Close any other open programs besides Pro Tracks check Windows Task Manager to make sure there are no
hidden programs running.

* Try reducing the number of plug-ins and soft-synths.

* Increase the amount of memory in your system.

* Get a faster hard drive.

* Put your audio data on a different hard drive from your OS and applications.

* Get a faster computer.

When | launch X Edit, it can’t find the Vx400.
* Make sure your drivers are loaded correctly and that the USB cable is inserted securely.
* See the section on USB Driver installation.

I hear doubling of the playback.
* Input monitoring is probably active. Go to Options->Audio->Input Monitoring to disable.

Mid, MidFreq. and Treble controls are not working.
* When USB is connected, the Mid, Mid Freq. and Treble controls function as Playback Mix, USB 1-2 Level, and
USB 3-4 Level controls. The tone controls can still be accessed from the editing matrix or from X Edit.

My instrument input didn’t record.
* Dry instrument can only be recorded on a separate track, not as part of a mix. To record the instrument in, go to
the setup level of the matrix and select IRV IN5 in USBI-2 Source or USB3-4 Source.
* Instrument with reverb or effects can be recorded as a mix with the microphone. The Mic setup must be set to
either INSRVH or INS F X,
My drums didn’t record.
* Drums can only be recorded on a separate track, not as part of a mix. To record drums, go to the setup level of

the matrix and select JRUMS in USB1-2 Source or USB3-4 Source.

My line inputs didn’t record.
* Dry line inputs can only be recorded on a separate track, not as part of a mix. To record line inputs, go to the
setup level of the matrix and select IR VL IN in USBI-2 Source or USB3-4 Source.

* Line with reverb or effects can be recorded as a mix with the microphone. The Line selector must be set to either
LINFVE or LINEFX.

I get dropout when | change presets during recording/playback.
* Changing presets during recording/playback will cause dropout of audio.

My mic/line inputs had dropout while | was recording.
* Changing presets while recording will cause dropout of audio to and from the computer.

Pro Tracks won’t launch.

 This was probably caused by interrupting the USB connection while in a previous Pro Tracks session. You must
reboot your system to fix this problem.

I don’t hear playback from USB 3-4.
* Playback is only available on USB |-2. USB 3-4 is used for additional track recording - like dry instrument, mic,
drums, etc.



CC Parameter List

CC Parameter

12 MIC ON/OFF
13 MIC SOURCE
14 MIC MODEL

I5 COMP ON/OFF
16 COMPTYPE

17 COMP GAIN

18 VOICE ON/OFF
19 VOICE TYPE

20 VOICE PARAM|
21 VOICE PARAM2
22 VOICE LEVEL
23 VOICE BYPASSLVL
24 EQ MIDFREQ
25 EQ BASS

26 EQ MIDRANGE
27 EQ TREBLE

28 GATE ON/OFF
29 GATE THRESH
30 FX ON/OFF

31 FXTYPE

32 FX PARAMI

33 FX PARAM2

34 FX LEVEL/MIX
35 DLY ON/OFF
36 DLY TYPE

37 DLY TIME

38 DLY FEEDBACK
39 DLY LEVEL

40 RVB ON/OFF
41 RVB TYPE

42 RVB DAMP

43 RVB DECAY

44 RVB LEVEL

45 PDLI ASSIGN
46 PDLI MIN

47 PDLI MAX

48 PDL2 ASSIGN
49 PDL2 MIN

50 PDL2 MAX

51 PDL3 ASSIGN
52 PDL3 MIN

53 PDL3 MAX

Appendix

Parameter

GLB PEDAL1POSITION
GLB MASTER LEVEL
GLB INSTRUMENT ROUTE
GLB LINEIN ROUTE
GLB USB1 ROUTE
GLB USB2 ROUTE

GLB OUTPUT ROUTE
GLB USB1 LEVEL

GLB USB2 LEVEL

GLB USB MIX
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Appendix
Factory Preset List

Number Preset Name Display Name Number Preset Name Display Name

1/41 Vocal Delay yvOCILY 21/61 Wizard WIZARD
2/42 Monster MONSTER 22/62 Warm Tube Delay TUBILY
3/43 50's Slapback Delay SLAPBK 23/63 Distorted Tremolo DSTREM
4/44 Grunge Vocal LRUNGE 24/64 Karaoke Delay HKARDKE
5/45 Thicken THICKN 25/65 Mars Man MARS

6/46 Vocal Plate FLATE 26/66 Whammy Man WHHMAN
7/147 Wah Voice WHHYOC 27167 Big Verb BIGVRE
8/48 Vibrato VIBRTD 28/68 Distorted Delay D5TILY
9/49 Tube Mic Preamp TURPRE 29/69 Helium HELTUM
10/50 Oh Yeah! OHYERH 30/70 Cyborg CVBORG
11/51 Breathy BRETHY 31/71 Billy Goat GORT

12/52 5th Up Pitch Shift 5TH UP 32/72 Invaders INVAIR
13/53 Telephone TELPHN 33/73 Megaphone MEGPHN
14/54 Alvin ALY IN 34/74 Chorus Verb CHORV B
15/55 Strobovoice STRO3E 35/75 Wiggly WIGGLY
16/56 Rich Detune JETUNE 36/76 Monster Pong MONPNG
17/57 Lo-Fi Lo FI 37177 Robot ROBOT
18/58 Phased Pong PHSPNG 38/78 Stutterer STUTTR
19/59 Compressed CMPRSST 39/79 Pixelator PIXLTR
20/60 Dark Force FORCE 40/80 Space Reverb SPACE

Specifications:
Inputs: Power Supply:
Instrument In; 1/4” Unbalanced 9VAC, 1300mA

Mic In: XLR Balanced w/Phantom Power
Line Inputs: 1/4” Balanced TRS
CD/Monitor: 1/8” Stereo TRS
Footswitch: 1/4” Stereo TRS

USB I.1

Outputs:

Line Outputs: 1/4” Unbalanced
Line Outputs: XLR Balanced
Headphone: 1/8” Stereo TRS
USB 1.1

A/DIA:
24 bit Delta Sigma Converters

Drum Machine:
30 Patterns + Metronome

Simultaneous Effects:
up to 8

Power Consumption:
10 Watts,

Current Draw:
675mA AC

DigiTech PS0913B - 100 (100V ~ 50/60Hz)
DigiTech PS0913B - 120 (120V ~ 60Hz)
DigiTech PS0913B - 230 (230V ~ 50Hz)
DigiTech PS0913B - 240 (240V ~ 50Hz)

Preset Memory:
40 User Presets
40 Factory Presets

Effects:

Microphone Models, Compressor, Noise Gate, Mic Pre /
Voice, EQ, Chorus, Flanger, Phaser, Tremolo, Vibrato, Strobe,
Doubler, Envelope, Pixelator, Detune, Pitch, Whammy ™,
Delay, and Reverb.

Dimensions:
85"Lx I3"W x225"H

Weight: 4.65 Ibs.
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